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Abstract 

In this work the effective applicability of electro-optic effect for the implementation of 

all logic gates in optical domain and Half Adder using Mach-Zehnder Interferometers 

(MZI) has been demonstrated. Performance enhancement using electro-optic switch 

implemented using MZIs based on Titanium diffused Lithium Niobate (Ti:LiNbO3) 

functioning as waveguide medium at 1.33 µm wavelength is detailed in the work. The 

designs implemented consist of one MZI for NOT gate, two MZIs for AND gate, three 

MZIs for OR gate, two MZIs for NOR gate, three MZIs for NAND gate, two MZIs for 

XOR gate, two MZIs for XNOR gate and three MZIs for half adder which are giving 

optimized operation in terms of low insertion losses, high extinction ratio and low 

switching voltage. Further the titanium strip thickness was varied and analysis of the 

device performance has been done. Mathematical description of the device operation 

is also included and the obtained results of MATLAB simulations and beam 

propagation method applied were compared and verified. 

The primary goal of developing the methods of optical digital computing is to 

significantly improve fundamental and complicated digital equipment. Optical digital 

computing methods offer the best choice for high-speed processing of data.  It can 

allow huge numbers of functions for signal processing like switching, addressing, 

encoding, and complicated digital computations. The EO effect is also very 

extensively investigated for the optical logic gates realization. For simplifying the 

system, the optical switching can be made using the EO effect in MZI. For optical 

signal processing and optical fiber communication, a Ti diffused lithium niobate 

waveguide is beneficial. The optical switching phenomenon has been researched in 

LiNbO3-based MZIs and its efficiency has been demonstrated in implementing 

multiple logic gates in optical domain, combinational circuits and routers. By using 

this phenomenon all logic gates in optical domain and combinational circuits are 

implemented using beam propagation method and results of these designs are verified 

using equations of mach-zehnder interferometer in MATLAB simulation.  
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CHAPTER 1: INTRODUCTION 

1.1 Introduction 

Today there has been a rapid increase in high bandwidth demand to achieve the 

electronic devices’ speed limit. Signal processing of all optical devices’ overall aim is 

still on the horizon. The ideal design of high-bit-rate logic gates in optical domain is 

now coming out of the laboratories. In this sector, the researchers are moving forward 

to make this possible. However, logic gates in digital domain have complex and bulky 

electro-optic transformation for signal processing in optical domain [1]. Electro-optic 

MZI has been widely used in optical systems recently due to high speed operation 

requirements. They find wide applicability due to their inherent advantages of 

reliability and high speed switching capabilities which makes them competent 

candidates in next generation optical networks. In the field of optoelectronics, high-

speed communication has been achieved by virtue of low complexity offered by these 

devices where optimization perform a major task in the fast processing of optical data 

[2]. To make the dream come true, optical gates are the fundamental necessity. Gates 

are the main components for performing all-optical tasks. Therefore, to realize digital 

gates on the same platform into all-optical logic gates, several fundamental designs 

need to be developed [3].  

Due to increased bandwidth demand, the scale of electronic devices to higher 

transmission rates is particularly challenging owing to their dissipation of power and 

use of energy [4-5]. Changing the optical packet is a pleasant replacement for boosting 

the forwarding speed of the router. An important segment of any router is a memory 

unit needed to store a packet's header intelligence shortly [6].  

For high-speed telecommunication systems, optical logic gates require 

significant elements as they have to achieve various functionalities in optical signal 

processing like switching, regeneration, addressing, multiplexing/demultiplexing, 

decision making, computation, coding/decoding and so on [7]. MZI switch is designed 

using titanium diffused lithium niobate because of which high speed of operation 

above the 40 Gb/s at long haul optical transmission system, large capacity, TE field in 

the direction of propagation, and zero residual birefringence, less complexity and high 

EO coefficient for less switching time can be attained [8-9]. Different types of 

materials and their configurations have been examined in this work to get the desired 

all-optical switches. For this purpose, the materials should possess high non-linearity 
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characteristics, low operating voltage to ensure quick response times and low 

switching losses in switching operation. Further, thermo-optic effect and electro-optic 

effect can also be employed [10]. 

Due to its unique characteristics of large bandwidth, low distortion of signal 

distribution, spatial coherence and high spectral, robustness of cosmic radiation’s 

robustness, and RF interference which is free, signal processing of optical digital has 

drawn extensive study interest in past years. Although different writers have shown 

their keen interest in designing the digital logic gates using different optical 

processing methods in the past, while designing of universal gates is the main problem 

in the processing of optical signals. NAND and NOR gates are called universal 

because with the support of these universal logic gates, all other logic operations can 

be performed [11-13]. A novel method is suggested to use the EO effect in MZI to 

create universal gates. Because of the electro-optic (EO) impact, the fundamental 

switching element in LiNbO3-based MZI is described. The LiNbO3 based MZI is 

distinguished by small size, thermal stability, reconfigurability, integration potential, 

low latency, and low power consumption appealing characteristics [14]. As a result, 

many researchers showed a keen interest in designing various combinational and 

sequential circuits using EO effect in MZIs. Universal logic gates implementation 

using LiNbO3-based MZI's electro-optic effect was illustrated in which writers 

developed that by inverting an AND operation output, the NAND gate is deployed and 

similarly, by inverting the OR operation output, the NOR gate is intended [15]. 

1.2 Objectives 

The primary goal of developing the methods of optical digital computing is to 

significantly improve fundamental and complicated digital equipment. Optical digital 

computing methods offer the best choice for high-speed processing of data.  It can 

allow huge numbers of functions for signal processing like switching, addressing, 

encoding, and complicated digital computations [16-17]. Many scholars have 

demonstrated the various processes for implementing the various combinational and 

sequential logic circuits. Using multiple optical signal processing methods, the 

fundamental combination logic gates such as AND Gate, OR Gate, and NOT logic 

gates are applied [18]. The EO effect is also very extensively investigated for the 

optical logic gates’ realization. For simplifying the system, the optical switching can 

be made using the EO effect in MZI [19]. To introduce the optical switches, the 
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electro-optic effect in MZI was used efficiently. Effectively study the switching 

phenomena in optical, the EO effect in MZI and implementation of optical 

combinational circuits is commonly investigated [20]. Major role of proper switching 

technology in determining any network’s workable design and can effectively enhance 

precision, flexibility, scalability and speed [21]. In electronic switching optoelectronic 

conversion takes place whereas in optical switching optoelectronic conversion is not 

occurring. Optical switch's speed and sensitivity must exactly match with photonic 

networks of new generation, where light directly regulates the switches in its route and 

carries data and routing information, but also. The lithium niobate electro-optic 

coefficient is well adapted for quick optical communication systems modulation and 

switching [21]. For optical signal processing and optical fiber communication, a Ti 

diffused lithium niobate waveguide is beneficial. The optical switching phenomenon 

has been researched in LiNbO3-based MZIs and its efficiency has been demonstrated 

in implementing multiple logic gates in optical domain, combinational circuits and 

routers [22]. By using this phenomenon all logic gates in optical domain and 

combinational circuits are implemented using beam propagation method and results of 

these designs are verified using equations of mach-zehnder interferometer in 

MATLAB simulation. 

1.3 Thesis Organization 

This thesis is organized in 7 chapters containing this introduction chapter. Following 

the introduction chapter, chapter 2 describe the literature survey of proposed work on 

optical logic gates and half adder using electro-optic effect in MZI. 

In chapter 3, we have describe the basic idea of the electro optic effect, 

properties of Lithium Niobate material and Titanium diffusion in Lithium Niobate, 

MZI switch behaviour and its mathematical equations are explained in detailed. 

In chapter 4, we have discuss about the block diagram of all logic gates like 

NOT, AND, OR, NOR, NAND, XOR, XNOR gates and half adder, and their 

mathematical equations and by these equations MATLAB simulation graph is 

explained. 

In chapter 5, simulator tool OPTI-BPM is discussed. How we can design a 

device through it and how any device is simulated in this simulator all steps are 

explained in this chapter. Design process of a basic MZI switch is also explained. 

Taking this design as a reference design, I have designed rest of all new designs. 
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In chapter 6, all designs, their optical field and obtained their graph of 

insertion loss and extinction ratio by varying Ti strip thickness are done. By the graph 

we obtained maximum value of extinction ratio and minimum value of insertion loss 

for all designs. 

Finally in chapter 7, conclusion of whole project and future work which can be 

done after this work is explained. 
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CHAPTER 2: LITERATURE SURVEY 

 

Ganguly, P. et. al. (1996) "Simulation of refractive index profiles for titanium in 

diffused lithium niobate channel waveguides" [6]. In this paper, Ti diffused 

waveguide on Y–cut and Z-cut lithium niobate substrate and observe refractive index 

for single and coupled waveguides using BPM. 

Singh G. et. al. (2010) "Ti in diffused lithium niobate (Ti: LiNbO3) Mach-Zehnder 

interferometer all optical switches: a review" [8]. In this paper, detailed about 

switching characteristics of MZI switch based on EO effect using Ti: LiNbO3 in 

waveguides. Losses are compare of this design with SOA-MZI and observe the 

extinction ratio an insertion loss. 

Singh G. et. al. (2011) "Modeling of a 2× 2 electro-optic Mach-Zehnder 

Interferometer optical switch with s-bend arms." [3]. In this paper, MZI switch with s-

bend interferometric arms is designed using Ti: LiNbO3. And observe the cross talk, 

extinction ration and switch losses. 

Singh Ghanshyam et. al. (2012) "Modeling of a high performance Mach--Zehnder 

interferometer all optical switch." [2]. In this paper MZI switch is designed using Ti: 

LiNbO3. Optimize and modeled Ti diffusion process and observe the impact of Ti 

strip thickness on cross talk, transition losses and first 3 dB coupler’s power 

imbalance. 

Mohammed, Nazmi A. et. al. (2012) "Performance Evaluation and Enhancement of 2× 

2 Ti: LiNbO3 Mach Zehnder Interferometer Switch at 1.3 μm and 1.55 μm." [16]. In 

this paper implement EO 2x2 switching device using Ti:LiNbO3 as waveguide at 1.33 

µm and 1.55 µm. Observe IL and ER for both wavelength. Capability and reliability 

of this switch is very high.   

Kumar, et. al. (2013) "Implementation of optical switches using Mach–Zehnder 

interferometer."  [4]. In this paper, observe effect of voltage which is varying of every 

electrode of the MZI structure. The results of this design are useful to design optical 

logic gate and the single router in dense wavelength division multiplexing. 

Kumar, et. al. (2015) "Design of D flip-flop and T flip-flop using Mach–Zehnder 

interferometers for high-speed communication." [7]. In this paper, speed of 

communication is low by using electrical component while using optical component 
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speed of communication is high. Different combinational circuits are designed using 

EO effect based MZI and results are obtained by BPM and MATLAB simulations. 

Kumar, et. al. (2015) "Proposed new approach to the design of universal logic gates 

using the electro-optic effect in Mach–Zehnder interferometers." [11]. In this paper, 

universal logic gates (NAND and NOR) are designed based on EO effect using 

Ti:LiNbO3 in MZI on BPM and results are verified by the MATLAB simulation. 

Observe the speed, latency and power consumption etc. influencing parameters. 

Khatun, et. al. (2015) "Optimization of 2× 2 MZI electro-optic switch and its 

application as logic gate." [19]. In this paper, EO-MZI is designed at1.55 µm for high 

speed of operation. Observe high ER, low IL and low switching voltage. Capability 

and reliability of this switch is very high.   

Kumar Harsh, et. al. (2017) "Gray to binary code converter using Ti-in diffused 

lithium niobate based Mach-Zehnder interferometer." [1]. In this paper describe that 

using XOR logic, 3 bit gray to binary code convertor designed using Ti:LiNbbO3 in 

MZI. At the output optical signal is obtained in form of binary. This device provides 

high speed of switching, minimum losses and high extinction ratio.  

MS Windows NT mzi switch optiwave, Accessed: 2019-06-03 [24]. This link 

provides the designing steps of MZI switch using Opti-BPM software and learn about 

this beam propagation method platform for designing of the proposed device.    
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CHAPTER 3: ELECTRO-OPTIC EFFECT IN MACH-

ZEHNDER INTERFEROMETER 

3.1 Introduction 

One of the most significant mediums to impose data on or modulate a light wave 

carrier is the EO effect. Electro-optic devices are created to be used for modulation or 

switching or so many purposes in optical communications. Example devices include 

phase and amplitude modulators. The electro-optic effect enables frequency 

modulation to be much greater than other techniques, such as mechanical shutters, 

moving mirrors or acousto-optic equipment, owing to quicker response time.  

The fundamental concept behind electro-optic systems is to alter in a 

controlled manner the material’s optical properties with an applied electric field. An 

optical signal's shift in optical properties refers to change in phase, amplitude, 

frequency, polarization, or position as it propagates through the device. According to 

change in properties we differentiate the electro-optic effect [8]. 

3.2 Electro-Optic Effect 

Some materials have the property that if an optical signal passes through it, its 

properties change according to applied external force. Reasons to change these 

properties are change in positions, orientations, or shapes of the molecules originating 

from the material by applying any external forces eg. Voltage, temperature, acoustic 

waves etc. The shift in the refractive index arising from the implementation of an 

electrical dc or low frequency field known as the electro-optic effect [8]. 

3.3 Lithium Niobate- A crystal for optical processing 

In linear and non-linear applications different kind of devices can be included like 

mobile device, optical modulators and sensors based on piezo-elecric effect all these 

are based Lithium Niobate crystal material. It is a compound material made of 

niobium, lithium, and oxygen, Lithium Niobate has a trigonal geometry class of R3c 

and 3m point group framework without anti symmetry and show properties of 

Ferroelectricity, Pockel’s impact, piezoelectric impact, photo elasticity and nonlinear 

optical polarizability. It is a hard no soluble in water having negative uniaxial 

birefringence dependent on the stoichiometry and temperature of the crystal. It can be 

operate under the range of 350 and 5200 nm wavelength. Single crystal of LN wafers 
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grown using the Czochralski process after then wafer is cut into different cuts eg. Z-

cut, X-cut, Y-cut 

Lithium Niobate (LiNbO3) is a colourless. It is insoluble with water. LiNbO3  

is a ferroelectric material. In integrated optics developers use its electro-optical 

characteristics, acousto-optical characteristics and non-linear optical characteristics 

and proved to be optical waveguides manufacture with great material. For 

communication technology high bandwidth property makes appropriate intrinsic 

modulation.  

Specification of lithium Niobate are described as that chemical formula of 

lithium Niobate is LiNbO3, crystal glass is trigonal with 3m, lithium Niobate is non-

soluble in water and colourless, molecular weight is 147.9 g/mol, density is 4.644 

g/cm3, transmittance range is 350-5500 nm, melting point is 1530 K, curie 

temperature is 1415 K, thermal conductivity is 5.6 W/(m K) at 300 K, and bandgap is 

4 eV. 

For multiple technical innovations, it’s piezoelectric and photo elastic 

characteristics were used. By virtue of its large EO coefficient, resistance of optical 

damage and minimum losses, lithium niobate was used to manufacture embedded 

waveguides. For wavelength-tunable polarization converters implementation Strain-

optic impacts are used. To design low-loss switches, LiNbO3 material has been used 

widely, but the main problem is their polarization dependence. For high and low 

velocity schemes, the selection of Lithium Niobate based switches is proven to be the 

best. The requirements of modulation in digital fiber optic TDM and WDM schemes 

have been effectively resolved by LiNbO3 devices in latest years [8]. 

3.4 Ti-diffused Lithium Niobate 

Waveguides which made of lithium niobate material can be manufactured using either 

in-diffusion of titanium or annealed proton exchange procedures to design switches 

and modulators. The entire LiNbO3 is subjected to the manufacture of planner 

waveguides while, with these procedures, the photolithography method is used to 

define masks for chosen areas on it. In some cases, to control optical damage, Mg 

oxide is doped with LiNbO3. The lithium niobate waveguides exchanged for protons 

are simple to manufacture and can function at low temperatures. For multiple 

communication, sensor systems and signal processing, Ti diffused lithium niobate 

waveguides are helpful. Ti doping in lithium niobate crystal increases refraction 
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indexes, allowing both TE and TM modes to propagate along the wave guides, which 

fulfils the necessary optical signal processing requirements [22]. 

3.5 MZI Switch 

Mach–Zehnder interferometer (MZI)-based structures are among the numerous 

techniques available to transform a modulation of phase into a modulation of 

intensity. These designs are widely used by electro-optic (EO) or thermo-optic (TO) 

impacts to create a various applications like optical modulators, splitters, switches, 

etc. The symmetric MZI structure was proposed to design high speed switches for 

lower bandwidth operation using the EO effects. Lithium niobate (LN) is an 

appropriate material for MZI structure based switches because of its large EO-

coefficients, but a latest material potassium niobate (KN) has recently been discovered 

that can substitute lithium niobate. These systems have stable performance 

parameters, even for inputs with a broad range of concentrations of optical power.  

Under the influence of an electric field MZI switches produce the refractive 

index in optical medium, due to this bending of light occur through the medium, this 

phenomenon is known as phase modulation. By optimized different design parameters 

like diffusion parameter, dimension of the waveguide, applied field etc., increase the 

performance of switch [9]. 

3.6 Mathematical Equations 

The refractive index of the light propagating through the arms of the interferometer 

faces a change on application of an electrical voltage. This variation in refractive 

index introduces phase shifts in the lights propagating through them which lead to a 

resultant output port switching. This transduction phenomenon is widely named as 

electro-optic effect where the light at the output port switches with application of an 

input bias [19]. The schematic layout of 2x2 MZI switch used in simulation analysis is 

shown in fig. 3.1 
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Figure 3.1: Structure of MZI [4] 

Following equation can be used to find out the corresponding phase change [19]. 

∆φ =  
2π

λ
(∆n)L               (3.1) 

Where, L is substantial length of interferometer arm  

∆n is the change in refractive index due to applied voltage that is represented by [19] 

∆n = (
n3

2
) rE                (3.2) 

r is electro-optic coefficient. For LiNbO3, r = 3.66× 10-10 m/V. 

 And ∆φ is shown below [19], 

∆φ =
2π

λ
[(

n3

2
) rE] L               (3.3) 

Let the distance between the two electrodes in figure 1 is d and the voltage difference 

between them to be V, then find E approximately equal to V/d. Then eq. (3.3) can 

deduce to eq. (3.4) [19]. 

∆φ =
2π

λ
[(

n3

2
)

V

d
r] L               (3.4) 

If ∆φ = zero, then it shows no voltage is applied. And when V is applied, then ∆φ = π. 

At this point, voltage is known as Vπ and is represented by eq. (3.5) [19]. 

Vπ =
λ

n3

1

r

d

L
                (3.5) 
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Now output ports normalized powers are given by eq. (3.6) [19]. 

                                                       Pout1 = sin2 (
∆φ

2
) 

                                                       Pout2 = cos2 (
∆φ

2
)                                                     (3.6) 

The device performance can be modelled by the IL and ER involved, where IL is the 

ratio of output power with respect to the input given by equation (3.7) [19]. 

IL(dB) = 10log10(
Pout

Pin
)              (3.7) 

Whereas the ratio of circuit ON state power to OFF state output power gives the ER 

and is given by eq. (3.8) [19]. 

ER(dB) = 10log10(
Pon

Poff
)              (3.8) 
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CHAPTER 4: MATLAB GRAPH OF ALL LOGIC GATES 

AND HALF ADDER 

4.1 NOT GATE 

Figure 4.1 depicts the layout used to structure the proposed NOT Gate. NOT gate 

inverts the applying input that is when logic 0 is applied at input then logic 1 is 

received at output and if logic 1 is applied at input then logic 0 I obtained at output.  

 

Figure 4.1: Block diagram of NOT Gate 

Mathematical equation for normalized power of MZI single staged circuit can be 

effectively used for normalized power evaluation at the output port of MZI-1 In this 

work as shown in figure output ports 1 (Fig.4.1) has been used for evaluation. The 

output power at both the output ports can be evaluated utilizing following equations: 

𝑚0 = |
OUT2MZI1

Ein
|

2

= cos2 (
∆φMZI1

2
)               (4.1) 

Eq. (4.1) is solved using the assumption given below,  

                                                     ∆φMZI1 =  
π

Vπ
A               (4.2) 

Signal A is controlling MZI-1 at second electrode of MZI-1, logic 0 is represented by 

0.00V and logic 1 is represented by 6.75V. Hence following expressions for output of 

proposed NOT Gate can be obtained as: 

Output port 1 (NOT Gate) = |
OUT1MZI2

Ein
|

2

= 𝑚0 = cos2 (
∆φMZI1

2
)             (4.3) 

Implementation of NOT Gate using MATLAB 

To implement the NOT gate single MZI was used, as represented in Fig. 4.1. At the 

input of MZI-1 the optical signal is applied and output port 1 is taken as output of 

NOT gate shown in the figure. Fig. 4.2 shows the results of MATLAB analysis of the 

implemented NOT gate. The first row in Fig. 4.2 represents the input control signals A 
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used in the simulation. The second row denotes the output obtained which is a NOT 

operation. 

 

Figure 4.2: MATLAB Simulation results of implemented NOT Gate using MZI’s 

4.2 AND GATE 

Figure 4.3 depicts the layout used to structure the proposed AND Gate. AND gate 

gives the output logic 1 when it’s both inputs are at logic 1, if any input is logic 0 the 

output will be logic 0. 

 

Figure 4.3: Block diagram of AND Gate 

Mathematical equation for normalized power of MZI single staged circuit can be 

effectively used for normalized power evaluation at the output port of MZI-2. In this 

work as shown in figure output ports 1 (Fig.4.3) has been used for evaluation. The 

output power at the output port can be evaluated utilizing following equations: 

𝑚3 = |
OUT1MZI2

Ein
|

2

= sin2 (
∆φMZI1

2
) sin2 (

∆φMZI2

2
)                             (4.4) 
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Eqs. (3.4) is solved using the assumptions given below,  

∆φMZI1
=  

π

Vπ
A 

                                                  ∆φMZI22
=  

π

Vπ
B                                                 (4.5)                                  

Signal A is controlling MZI-1 and Signal B is controlling MZI-2. At second electrode 

of each MZI, logic 0 is represented by 0.00V and logic 1 is represented by 6.75V. 

Hence following expressions for output of the proposed AND gate can be obtained as: 

Output port 1 (AND logic) = |
OUT1MZI2

Ein
|

2

= 𝑚3 = sin2 (
∆φMZI1

2
) sin2 (

∆φMZI2

2
)      (4.6) 

Implementation of AND Gate using MATLAB 

To implement the AND gate two MZI’s were used, as represented in Fig. 4.3. At the 

input of MZI-1 the optical signal is applied and its one of the output port (bar port) is 

connected to the first input port of MZI-2 and cross port in not connected further. The 

output port 1 of MZI-2 is taken as output of AND gate shown in the figure. Fig. 4.4 

shows the results of MATLAB analysis of the implemented AND gate. The first and 

second rows in Fig. 4.4 represent the input control signals A and B respectively used 

in the simulation. The third row denotes the outputs obtained which is the AND 

operations. 

 

Figure 4.4: MATLAB Simulation results of implemented AND Gate using MZI’s 
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4.3 OR GATE 

Figure 4.5 depicts the layout used to structure the proposed OR Gate. OR gate gives 

output logic 0 when it’s both inputs are logic 0, if any of the input is logic 1 then 

output will be logic 1. 

 

Figure 4.5: Block diagram of OR Gate 

Mathematical equation for normalized power of MZI single staged circuit can be 

effectively used for normalized power evaluation at the output port of MZI-3. In this 

work as shown in figure output ports 3 (Fig.4.5) has been used for evaluation. The 

output power at the output port can be evaluated utilizing following equations: 

𝑚1 = |
OUT1MZI3

Ein
|

2

= cos2 (
∆φMZI1

2
) sin2 (

∆φMZI2

2
) sin2 (

∆φMZI3

2
)              (4.7) 

𝑚2 = |
OUT1MZI3

Ein
|

2

= sin2 (
∆φMZI1

2
) cos2 (

∆φMZI2

2
) cos2 (

∆φMZI3

2
)                              (4.8) 

𝑚3 = |
OUT1MZI3

Ein
|

2

= sin2 (
∆φMZI1

2
) sin2 (

∆φMZI2

2
) sin2 (

∆φMZI3

2
)                               (4.9)                         

Eqs. (3.7)- (3.9) are solved using the assumptions given below,  

 ∆φMZI1
=  

π

Vπ
A 

                                                         ∆φMZI2
=  

π

Vπ
B                                   (4.10) 

 ∆φMZI3
=  

π

Vπ
B 

Signal A is controlling MZI-1 and Signal B is controlling MZI-2 and MZI-3. At 

second electrode of each MZI, logic 0 is represented by 0.00V and logic 1 is 

represented by 6.75V. Hence following expressions for output of the proposed AND 

gate can be obtained as: 
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Output port 3 (OR logic) = |
OUT1MZI2

Ein
|

2

= 𝑚1 + 𝑚2 + 𝑚3 

                                         = cos2 (
∆φMZI1

2
) sin2 (

∆φMZI2

2
) sin2 (

∆φMZI3

2
) 

                     +sin2 (
∆φMZI1

2
) cos2 (

∆φMZI2

2
) cos2 (

∆φMZI3

2
) 

                                              +sin2 (
∆φMZI1

2
) sin2 (

∆φMZI2

2
) sin2 (

∆φMZI3

2
)                   (4.11) 

Implementation of OR Gate using MATLAB 

To implement the OR gate three MZI’s were used, as represented in Fig. 4.5. At the 

input of MZI-1 and MZI-2 the optical signal is applied and one of the output port, bar 

port of MZI-1 is connected to the first input port of MZI-3 and cross port in not 

connected further. The bar port of MZI-2 is connected to the second input port of 

MZI-3. The output port 2 of MZI-3 is taken as output of OR gate shown in the figure. 

Fig. 4.6 shows the results of MATLAB analysis of the implemented OR gate. The first 

and second rows in Fig. 4.6 represent the input control signals A and B respectively 

used in the simulation. The third row denotes the outputs obtained which is the OR 

operations. 

 

Figure 4.6: MATLAB Simulation results of implemented OR Gate using MZI’s 
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4.4 NOR GATE 

Figure 4.7 depicts the layout used to structure the proposed NOR Gate. NOR gate 

gives output logic 1 when it’s both inputs are logic 0, if any of the input is logic 1 then 

output will be logic 0. 

 

Figure 4.7: Block diagram of NOR Gate 

Mathematical equation for normalized power of MZI single staged circuit can be 

effectively used for normalized power evaluation at the output port of MZI-2. In this 

work as shown in figure output ports 2 (Fig.4.7) has been used for evaluation. The 

output power at the output port can be evaluated utilizing following equations [11]: 

𝑚0 = |
OUT1MZI2

Ein
|

2

= cos2 (
∆φMZI1

2
) 𝑐𝑜𝑠2 (

∆φMZI2

2
)              (4.12)                                            

Eqs. (4.12) is solved using the assumptions given below [11],  

    
∆φ

MZI1
=  

π

Vπ
A 

                                                           ∆φMZI2
=  

π

Vπ
B                                   (4.13) 

Signal A is controlling MZI-1 and Signal B is controlling MZI-2. At second electrode 

of each MZI, logic 0 is represented by 0.00V and logic 1 is represented by 6.75V. 

Hence following expressions for output of the proposed AND gate can be obtained as 

[11]: 

Output port 1 (NOR logic) = |
OUT1MZI2

Ein
|

2

= 𝑚0 = cos2 (
∆φMZI1

2
) cos2 (

∆φMZI2

2
)   (4.14) 

Implementation of NOR Gate using MATLAB 

To implement the NOR gate two MZI’s were used, as represented in Fig.4.7.  At the 

input of MZI-1 the optical signal is applied and its one of the output port (cross port) 

is connected to the second input port of MZI-2 and bar port in not connected further. 

The output port 2 of MZI-2 is taken as output of NOR gate shown in the figure. 
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Fig.4.8 shows the results of MATLAB analysis of the implemented NOR gate. The 

first and second rows in Fig.4.8 represent the input control signals A and B 

respectively used in the simulation. The third row denotes the outputs obtained which 

is the NOR operations. 

 

Figure 4.8: MATLAB Simulation results of implemented NOR Gate using MZI’s 

4.5 NAND GATE 

Figure 4.9 depicts the layout used to structure the proposed NAND Gate. NAND gate 

gives the output logic 1 when its any of the input are at logic 0, if both inputs are logic 

1 then the output will be logic 0. 

 

Figure 4.9: Block diagram of NAND Gate 

Mathematical equation for normalized power of MZI single staged circuit can be 

effectively used for normalized power evaluation at the output port of MZI-3. In this 
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work as shown in figure output ports 3 (Fig.4.9) has been used for evaluation. The 

output power at the output port can be evaluated utilizing following equations [11]: 

𝑚0 = |
OUT1MZI3

Ein
|

2

= cos2 (
∆φMZI1

2
) cos2 (

∆φMZI2

2
) cos2 (

∆φMZI3

2
)           (4.15) 

𝑚1 = |
OUT1MZI3

Ein
|

2

= cos2 (
∆φMZI1

2
) sin2 (

∆φMZI2

2
) sin2 (

∆φMZI3

2
)                            (4.16) 

𝑚2 = |
OUT1MZI3

Ein
|

2

= sin2 (
∆φMZI1

2
) cos2 (

∆φMZI2

2
) cos2 (

∆φMZI3

2
)                            (4.17)                         

Eqs. (4.15)-(4.17) are solved using the assumptions given below [11],  

∆φMZI1 =  
π

Vπ
A 

                                                         ∆φMZI2 =  
π

Vπ
B                                   (4.18) 

∆φMZI3 =  
π

Vπ
B 

Signal A is controlling MZI-1 and Signal B is controlling MZI-2 and MZI-3. At 

second electrode of each MZI, logic 0 is represented by 0.00V and logic 1 is 

represented by 6.75V. Hence following expressions for output of the proposed NAND 

gate can be obtained as [11]: 

Output port 3 (OR logic) = |
OUT1MZI2

Ein
|

2

= 𝑚0 + 𝑚1 + 𝑚2 

                                        = cos2 (
∆φMZI1

2
) cos2 (

∆φMZI2

2
) cos2 (

∆φMZI3

2
) 

                  +cos2 (
∆φMZI1

2
) sin2 (

∆φMZI2

2
) sin2 (

∆φMZI3

2
) 

                                            +sin2 (
∆φMZI1

2
) cos2 (

∆φMZI2

2
) cos2 (

∆φMZI3

2
)           (4.19) 

Implementation of NAND Gate using MATLAB 

To implement the NAND gate three MZI’s were used, as represented in Fig. 4.9. At 

the input of MZI-1 and MZI-2 the optical signal is applied and one of the output port, 

cross port of MZI-1 is connected to the first input port of MZI-3 and bar port in not 

connected further. The cross port of MZI-2 is connected to the second input port of 

MZI-3. The output port 1 of MZI-3 is taken as output of NAND gate shown in the 

figure. Fig.4.10 shows the results of MATLAB analysis of the implemented NAND 

gate. The first and second rows in Fig.4.10 represent the input control signals A and B 
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respectively used in the simulation. The third row denotes the outputs obtained which 

is the NAND operation. 

 

Figure 4.10: MATLAB Simulation results of implemented NAND Gate using MZI’s 

4.6 XOR GATE 

Figure 4.11 depicts the layout used to structure the proposed XOR Gate. XOR gate 

gives logic 1 when odd number of inputs are logic 1 and when even number of inputs 

are logic 1 then output will be logic 0.   

 

Figure 4.11: Block diagram of XOR Gate 

Mathematical equation for normalized power of MZI single staged circuit can be 

effectively used for normalized power evaluation at the output port of MZI-2. In this 

work as shown in figure output ports 2 (Fig.4.11) has been used for evaluation. The 

output power at the output port can be evaluated utilizing following equations: 

𝑚1 = |
OUT2𝑀𝑍𝐼2

Ein
|

2

= cos2 (
∆φMZI1

2
) sin2 (

∆φMZI2

2
)           (4.20) 

𝑚2 = |
OUT2𝑀𝑍𝐼2

Ein
|

2

= sin2 (
∆φMZI1

2
) cos2 (

∆φMZI2

2
)           (4.21) 
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Eqs. (4.20)-(4.21) are solved using the assumptions given below,  

∆φMZI1 =  
π

Vπ
A 

                                                         ∆φMZI2 =  
π

Vπ
B                                   (4.22) 

Signal A is controlling MZI-1 and Signal B is controlling MZI-2. At second electrode 

of each MZI, logic 0 is represented by 0.00V and logic 1 is represented by 6.75V. 

Hence following expressions for output of the proposed XOR gate can be obtained as: 

Output port 2 (XOR logic) = |
OUT1MZI2

Ein
|

2

= 𝑚1 + 𝑚2 

                         = cos2 (
∆φMZI1

2
) sin2 (

∆φMZI2

2
) + sin2 (

∆φMZI1

2
) cos2 (

∆φMZI2

2
)         (4.23) 

Implementation of XOR Gate using MATLAB 

To implement the XOR logic two MZI’s were used, as represented in Fig. 4.11. At the 

input of MZI-1 the optical signal is applied and its both output ports as shown in the 

figure are connected directly to MZI-2 input ports. In MZI-2, the one of the output 

port, the cross port is taken as the output XOR operation. Fig. 4.12 shows the results 

of MATLAB analysis of the implemented half adder. The first and second rows in 

Fig. 4.12 represent the input control signals A and B respectively used in the 

simulation. The third row denotes the outputs obtained which is XOR operations. 

 

Figure 4.12: MATLAB Simulation results of implemented XOR Gate using MZI’s 
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4.7 XNOR GATE 

Figure 4.13 depicts the layout used to structure the proposed XNOR Gate. XNOR gate 

gives logic 1 when its both inputs are same, if inputs are different then output will be 

logic 0. 

 

Figure 4.13: Block diagram of XNOR Gate 

Mathematical equation for normalized power of MZI single staged circuit can be 

effectively used for normalized power evaluation at the output port of MZI-2. In this 

work as shown in figure output ports 2 (Fig.4.13) has been used for evaluation. The 

output power at the output port can be evaluated utilizing following equations: 

𝑚0 = |
OUT2𝑀𝑍𝐼2

Ein
|

2

= cos2 (
∆φMZI1

2
) cos2 (

∆φMZI2

2
)           (4.24) 

𝑚3 = |
OUT2𝑀𝑍𝐼2

Ein
|

2

= sin2 (
∆φMZI1

2
) sin2 (

∆φMZI2

2
)           (4.25) 

Eqs. (4.24)-(4.25) are solved using the assumptions given below,  

∆φMZI1 =  
π

Vπ
A 

                                                         ∆φMZI2 =  
π

Vπ
B                                   (4.26) 

Signal A is controlling MZI-1 and Signal B is controlling MZI-2. At second electrode 

of each MZI, logic 0 is represented by 0.00V and logic 1 is represented by 6.75V. 

Hence following expressions for output of the proposed NAND gate can be obtained 

as: 

Output port 1 (XNOR logic) = |
OUT1MZI2

Ein
|

2

= 𝑚0 + 𝑚3 

                        = cos2 (
∆φMZI1

2
) sin2 (

∆φMZI2

2
) +  sin2 (

∆φMZI1

2
) cos2 (

∆φMZI2

2
)          (4.27) 
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Implementation of XNOR logic using MATLAB 

To implement the XNOR logic two MZI’s were used, as represented in Fig. 4.13. At 

the input of MZI-1 the optical signal is applied and its both output ports as shown in 

the figure are connected directly to MZI-2 input ports. In MZI-2, the one of the output 

port, the bar port is taken as the output XNOR operation. Fig. 4.14 shows the results 

of MATLAB analysis of the implemented half adder. The first and second rows in 

Fig. 4.14 represent the input control signals A and B respectively used in the 

simulation. The third row denotes the outputs obtained which is an XNOR operation. 

 

Figure 4.14: MATLAB Simulation results of implemented XNOR Gate using MZI’s 

4.8 HALF ADDER 

Figure 4.15 depicts the layout used to structure the proposed half adder. Half adder is 

a combinational circuit in digital  electronics which adds two, one bit binary digits and 

generates two bits where one bit is sum, obtained by XOR operation and the other is 

carry bit generated by AND operation. 

 

Figure 4.15: Block diagram of Half Adder 
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Mathematical equation for normalized power of MZI single staged circuit can be 

effectively used for normalized power evaluation at the output ports of MZI-2 and 

MZI-3 [3-4]. In this work as shown in figure output ports 3 and 1 (Fig.4.15) 

respectively has been used for evaluation. The output power at both the output ports 

can be evaluated utilizing following equations: 

𝑚1 = |
OUT2MZI21

Ein
|

2

= cos2 (
∆φMZI1

2
) sin2 (

∆φMZI2

2
)           (4.28) 

𝑚2 = |
OUT2MZI22

Ein
|

2

= sin2 (
∆φMZI1

2
) cos2 (

∆φMZI2

2
)                         (4.29) 

𝑚3 = |
OUT1MZI3

Ein
|

2

= sin2 (
∆φMZI1

2
) sin2 (

∆φMZI2

2
) sin2 (

∆φMZI3

2
)     (4.30) 

Eqs. (4.28)-(4.30) are solved using the assumptions given below,  

∆φMZI1
=  

π

Vπ
A 

                                                         ∆φMZI2
=  

π

Vπ
B                                   (4.31) 

∆φMZI3
=  

π

Vπ
B 

Signal A is controlling MZI-1 and Signal B is controlling MZI-2 and MZI-3. At 

second electrode of each MZI, logic 0 is represented by 0.00V and logic 1 is 

represented by 6.75V. Hence following expressions for sum and carry of the proposed 

half adder can be obtained as: 

Output port 3 (XOR logic for sum of half adder) = |
OUT1MZI2

Ein
|

2

= 𝑚1 + 𝑚2 

        = cos2 (
∆φMZI1

2
) sin2 (

∆φMZI2

2
) +  sin2 (

∆φMZI1

2
) cos2 (

∆φMZI2

2
)           (4.32) 

Output port 1 (AND logic for carry of half adder) = |
OUT1MZI3

Ein
|

2

= 𝑚3 

= sin2 (
∆φMZI1

2
) sin2 (

∆φMZI2

2
) sin2 (

∆φMZI3

2
)           (4.33) 

Implementation of Half Adder using MATLAB 

To implement the half adder three MZI’s were used, as represented in Fig. 4.15. At 

the input of MZI-1 the optical signal is applied and its both output ports as shown in 

the figure are connected directly to MZI-2 input ports. In MZI-2, the one of the output 

port, the bar port is connected to the first input port of MZI-3 and other, the cross port 
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is taken as the output port of the circuit giving the resultant sum of the half adder 

circuit implemented (XOR operation). The carry generated by the circuit can be 

obtained at bar port as shown in the figure which is the first output port of MZI-3. Fig. 

4.16 shows the results of MATLAB analysis of the implemented half adder. The first 

and second rows in Fig. 4.16 represent the input control signals A and B respectively 

used in the simulation. The third and fourth row denotes the outputs obtained which 

are the sum and carry obtained through XOR and AND operations. 

 

Figure 4.16: MATLAB Simulation results of implemented Half Adder using MZI’s 
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CHAPTER 5: OPTI-BPM TOOL 

5.1 Introduction 

In this chapter, there is brief discussion about OPTI-BPM simulator tool. Expanded 

form of name OptiBPM is Optical Beam Propagation Method. For various embedded 

and fiber optics, BPM which is strong and user friendly software, gives a platform for 

designing wave issue on our desktop. “Beam Propagation Method (BPM) is a method 

of simulating in which device simulate step-by-step as light passes through any 

waveguide medium". As an optical signal propagates along a waveguide design, an 

optical field can be verified at any level. BPM allows computer-simulated analysis of 

the distribution of light fields. The radiation and the guided field can be observed at a 

moment. OptiBPM makes it possible to design waveguide equipment with simple data 

entry. and freely design devices and operate different simulations. 

It is possible to simulate an optical signal in OptiBPM in 2D and 3D waveguide 

devices [23]. 

 In 2D, X-direction which is vertical, behave as Transverse and Z-direction 

which is horizontal, behave as Propagation. 

 In 3D, X-direction which is vertical, behave as Transverse, Y-direction is 

behave as Depth and Z-direction which is horizontal, behave as Propagation. 

From a real three dimensional device to acquire a 2D device, an effective index 

method can be implemented. The transverse cross-section of two dimension device is 

replaced by a cross-section of one-dimensional to achieve a three dimensional device 

from two dimensional device. One dimension efficient index distribution exchanges 

the actual index cross-section. While an approximate solution is the efficient index 

method, it operates for many devices. 

All the functions which are needed to design step-index waveguide are 

provided by beam propagation method in 3D. The data design input comprises of the 

distribution of refractive index, propagation field for initiation, and numerical 

parameters set in the three-dimensional beam propagation method. The project's 

waveguide design offers refraction distribution index. The initial field could be a 

waveguide mode, Gaussian, rectangular, or a field defined by user provided from a 

file. There is a Global Data dialog box in which all simulation parameters are 

specified and this dialog box can be accessed via the Simulation menu. Output 

information includes many kinds of file that can be shown by other simulations [23]. 
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5.2 Numerical Simulations 

The simulating environment for OptiBPM consists of the Beam Propagation Method 

as the main component, along with mode solvers that match the algorithms of the 

Beam Propagation Method. BPM's basic concept is mathematical model equation 

that controls propagation of light in dielectric medium. BPM is related to solving the 

Helmholtz equation and considers monochromatic signals. The advantage of 

propagation models based on Helmholtz equation approximations might be – [23] 

 reduce complexity of the simulations    

 to faster the response 

 organize computer memory better 

5.3 2D BPM 

Crank-Nicolson's unconditionally stable finite difference method algorithm is the 

fundamental 2D BPM simulator base. Customization of following programme can be 

done of the following programme option, according to the design – [23] 

 Algorithms that give a decision between transverse electrical and transverse 

magnetic polarization.    

 Pade-based wide-angle propagation, Pade (1,1) and (2,2) to (4,4) 

 A rectangular field, a Gaussian field or field defined by use are the choice of 

field as a waveguide mode. 

 At an angle initial field could be started.  

 Modal, average or user-defined refractive index selection 

 Transparent boundary condition (TBC) 

5.4 3D BPM 

The simulator for 3D beam propagation method is based on ADI scheme, scalar 

algorithms, a choice provided by Semi-Vector algorithms between quasi TE and quasi 

TM polarization, and both component transversal fields are governed by Full-Vector 

algorithms [23]. 

5.5 Mode solvers 

Two and three dimensions algorithm of mode solver is compatible with OptiBPM 

software.  The mode solvers use various techniques that will be for multilayer planar 
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design that will be TMM, ADI in 2D and 3D respectively and CFM in both 

dimensions. 

The planar structure concept is based on the resolution at dielectric interfaces 

of different boundary conditions between layers. During the propagation of a user-

defined field, the CFM calculates the integral correlation between the input field and 

the propagation field at each stage. This produces the correlation feature of the field 

amplitude of the waveguide. The correlation function contains all the data needed to 

fully describe the fields, including the constant propagation, the weights of every 

mode, and eigen functions of each mode. 

The ADI method divides the derivatives of X and Y into two single iteration 

phase parts. Due to its rapid convergence, this technique is superior to certain finite-

difference methods. All constants of propagation and eigen function mode given by 

ADI method [23]. 

5.6 Basic Steps to design a basic Mach Zehnder switch in OPTI-BPM 

Details on how to build a design, operate a simulation, view the simulation outcomes 

and save the design project are given in this chapter. For fast starting settings and 

values used here. Use the settings and values are require when we creating our own 

projects [24]. 

The following applications are available in OptiBPM - 

 OptiBPM Layout Designer 

 Profile Designer 

 OptiBPM Simulator 

 OptiBPM Analyzer 

To get started, a design project will be generated in the Designer and project will be 

saved as a .bpd file. 

In the OPTI-BPM official website, all processes are described in detail. But 

these steps are briefly described below and can be referred to this for thorough 

knowledge of OPTI-BPM. Here, the built-in switch is supposed to be built on a 

Lithium Niobate z-cut wafer and enclosed by air cladding. The structure is oriented in 

the direction of Lithium Niobate's Y-optical axis. We therefore need to identify a 

diffused substrate material and a dielectric cladding material. 

A tool used in embedded fiber optics is an EO switch. For MZI, a substrate is 

made up of Titanium diffused Lithium Niobate. By the electro-optic effect switching 
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is done in the proposed structure. The electric field is distributed in structure by 

applying voltage in the electrode region of MZI which results into change in its 

refractive index. If design is perfect then change in refractive index results into 

distinct coupling between ports. 

Designing procedure steps are as following: [24] 

 Layout of CAD design 

 Describing the materials  

 Defining the profile of Ti-diffusion 

 Creating the Wafer 

 Describing the device 

 Creating the region of electrode 

 Creating the input plane and parameters of simulation 

 Simulation  

Layout of CAD design 

We imagine the embedded switch will be produced on a Lithium Niobate z-cut wafer 

and will be enclosed by air cladding. The structure is oriented in the direction of 

Lithium Niobate's Y-optical axis.  We therefore need to identify a diffused substrate 

material and a dielectric cladding material. 

Describing the materials 

Step 1: In the Layout Designer open a new project then dialog box of Initial 

Properties is pop up. 

Step 2: To open the Profile Designer click on the profiles and materials and following 

diffused material is created that is Lithium_Niobate is the name of crystal, z is the 

Crystal cut and y is the propagation direction. Then following dielectric material is 

defined that is Name is air and Refractive Index is 1. 

Defining the profile of Ti-diffusion 

Step 3: Define Profile name is TiLiNbO3 Pro 1 in the Profile Designer. 

Step 4: In the Profile Designer select Group I panel then define 3.5 µm Lateral 

Diffusion length and 4.2 µm is Diffusion length in Depth. After that Profile Designer 

is closed and Layout Design is appeared.  
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Figure 5.1: Dialog box of Profile Designer 

Creating the Wafer 

Step 5: Waveguide Properties tab open in Initial Properties dialog box and define 

Width is 8.0 µm and Profile is TiLiNbO3 Pro 1. 

Step 6: After that Wafer Dimension tab is open and define wafer length is 33000 µm 

and wafer width is 100 µm. 

Step 7: Then 2D Wafer properties tab is open and define Wafer Refractive Index 

Material is Lithium_Niobate. 

Step 8: After that 3D Wafer Properties tab is open and defines air is the material of 

cladding, 2 µm is the thickness of cladding, Lithium_Niobate is the material of 

substrate and 10 µm is the thickness of substrate. Then to save all settings click OK. 

Describing the device 

Step 8: To see the whole substrate, following setting will done as select 

Preference>Layout Options> Display ratio, and enter 200. 

In designing of MZI through selecting different waveguides with different shapes like 

here we use SBendSin waveguide which is curved shape and Linear waveguide which 

is straight. Table 5.1 describe the horizontal and vertical dimensions of each SBendSin 

and Linear waveguide.    
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Table 5.1: Create waveguides in Layout Designers [24]: 

Name of 

Waveguide 

Horizontal  

Start Position 

Vertical Start 

Position  

Horizontal End 

Position 

Vertical End 

Position 

SBendSin1 0 -20 5750 -7.25 

Linear1 5750 -7.25 9000 -7.25 

SBendSin2 9000 -7.25 11500 -116 

Linear2 11500 -16 21500 -16 

SBendSin3 21500 -16 24000 -7.25 

Linear3 24000 -7.25 27250 -7.25 

SBendSin4 27250 -7.25 33000 -20 

 Step 9: Select all the waveguide on the layout.  

Step 10: To create the top waveguides mirror and flip operations is perform by Edit > 

Flip and Mirror > Mirror to top menu. By this a duplicate waveguides is obtained 

above the selected waveguide. 

Step 11: After that open the properties dialog box by double-clicking on the each 

waveguide and enter the x-coordinates values in the horizontal coordinate which 

remains same and vertical coordinates which is reverse sign of its counterpart of 

selected waveguide  

 

Figure 5.2: Waveguide design on Layout 

Perform the following steps to check RI profile for selection of z- distance of x-y 

slice: 

Step 12: Choose the Ref. Index (n)–On the bottom of the design designer window, the 

3D XY Plane view tab. Then select Z distance from Select Preference > Refractive 

Index View > 3D Slice (XY Plane) > Select Z Distance.  

Step 13: Dialog box of XY Refractive Index view option is pop up in which enter Z 

distance value and click on view. By this Z distance is updated. 
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Figure 5.3: Steps for selecting Z distance 

 

Figure 5.4: Refractive Index view in which Z distance is entered 

Creating the region of electrode 

Step 14: To select electrode region go through as Select Draw > Regions > Electrode 

Region. 

Step 15: After that click and move the mouse where we draw the electrode region on 

the layout. Electrode region is drawn. 

Step 16: Double click on electrode region then dialog box is pop up where we enter 

start and end positions 11500 µm and 21500 µm respectively of the electrode region. 

 

Figure 5.5: Steps for selecting Electrode Region 
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Figure 5.6: Dialog box in which define length of electrode region 

Step 17: In electrode tab, buffer layer properties can be defined to build electrode on 

the top of buffer layer. 

Step 18: For defining buffer layer select All sets > Electrode with buffer layer where 

on 0.3 µm is the thickness of Buffer layer, 4 is the horizontal permittivity and vertical 

permittivity, 4 µm is the thickness of electrode and material is buffer. 

Step 19: Click on material in use for defining the new dielectric material in Profile 

Designer, where enter the name is Buffer and Refractive Index is 1.47. 

Step 20: For Electrode Set dialog box , under Electrode sets table, click Add and then 

in Electrode 1 enter width is 50 and voltage is 0.0, in Electrode 2 enter width is 26 and 

voltage is 0.0, in Electrode 3 enter width is 50 and voltage is 0.0, gap 1-2 is 6.0, gap 2-

3 is 6.0 and last center position of Electrode 2 is 5.5. At last close all the dialog boxes. 

 

Figure 5.7: Defining electrodes with Buffer layer 
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We defined an electrode region with three electrodes, all with zero voltage, slightly 

off the Mach-Zehnder interferometer's symmetry axis. 

 

Figure 5.8: Define electrode set 

Creating the input plane and parameters of simulation 

Step 21: To draw input plane select Draw > Input plane in the layout. 

Step 22: In the dialog box of the Input Plane properties enter starting field is Mode, Z 

position offset is 0.0, then open 2D input field tab > click edit and dialog box of input 

field is pop up, after that select second waveguide and click on Add in waveguide 

table and this entry is appear in field table, then close all dialog box. 

Step 23: Performing the simulation we select Simulation > Simulation parameter and 

dialog box is pop up. In this dialog box, Global Data tab enter Reference Index is 

Modal and Wavelength is 1.33 µm. 

Step 24: In 2D tab enter Polarization is TM, number of points of mesh is 500, BPM 

solver is paraxial, finite difference engine, 0.5 is the scheme parameter, Propagation 

Step is 1.3 and choose Transparent Boundary Condition (TBC). Then close all dialog 

boxes. 

Simulation  

Step 25: To perform simulation, select Simulation > Calculate 2D Isotropic 

Simulation and dialog box appears, then click on Run and OptiBPM Simulator 2D is 

open. 
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Step 26: Simulation is Run for two values of voltage 0.0 (logic 0) and 6.75 (logic 1) 

and this voltage is changed by the central electrode voltage in Electrode Region dialog 

box, click on Edit and enter the values 0.0 or 6.75 in Electrode 2 – Voltage (V). 

 

Figure 5.9: Simulation results of MZI 
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CHAPTER 6: PROPOSED DESIGNS OF OPTICAL 

LOGIC GATES AND HALF ADDER 

In this chapter optical logic gates and half adder is discussed. Designs which I have 

developed are given in details with the simulation results and required parameters. By 

using these results, Insertion Loss and Extinction Ratio of designs are calculated. 

These circuits designed using OptiBPM software which is explained in chapter 4. We 

have discussed about logic gates and half adder designs which shows the high value of 

extinction ratio along with the small value of insertion loss.  

 NOT Gate 

 AND Gate 

 OR Gate 

 NOR Gate 

 NAND Gate 

 XOR Gate 

 XNOR Gate 

 Half Adder 

Detailed explanation of each design is given in the following subsection with 

important parameters like Insertion Loss and Extinction Ratio Calculation. 

6.1 NOT Gate 

To implement the NOT gate single MZI was used, as represented in Fig. 4.1. At the 

input of MZI-1 the optical signal is applied and at cross port is taken as output of NOT 

gate shown in the figure. Fig. 6.1 shows the structure of the implemented NOT gate 

using OptiBPM.  

 

Figure 6.1: Layout structure of NOT Gate 

The results of simulation using BPM is shown in Fig. 6.2, where the NOT gate is seen 

to give acceptable results through proper selection of control signal. The operating 
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principle of the proposed structure can be well monitored using the truth table, Table. 

6.1. The results of simulation based analysis has been compared with the BPM results 

for its validation and verification as shown in Fig. 6.2  

Table 6.1: Input and output of NOT Gate layout 

Control/Input 

Signal 

Outputs 

A Port 1  

(C = NOT A) 

Port 2 

 

0 1 0 

1 0 1 

 

Figure 6.2: Results of NOT Gate using beam propagation method 

Impact of Ti strip thickness on IL and ER  

In this, impact of Ti strip thickness on power performance of the NOT gate has been 

investigated by varying the thickness of Ti strip from 0.05 µm to 0.09 µm and plot the 

graph between the extinction ratio and the thickness of titanium strip and insertion 

loss and thickness of titanium strip. And we obtain the highest value 28.68 dB of 

extinction ratio and lowest value of insertion loss 0.050 dB at the 0.05 µm thickness 

and we increase or decrease the titanium thickness the extinction ratio will be low and 

insertion ratio will be high. 

 

(a)                   (b) 

Figure 6.3: (a) Variation of ER with increase in thickness of Ti strip of NOT Gate (b) Variation of IL 

with increase in thickness of Ti strip of NOT Gate 
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6.2 AND GATE 

To implement the AND gate two MZI’s were used, as represented in Fig. 4.3. At the 

input of MZI-1 the optical signal is applied and bar port of MZI-2 is taken as output of 

AND gate shown in the figure. Fig. 6.4 shows the structure and results of the 

implemented AND gate using OptiBPM.  

 

Figure 6.4: Layout structure of AND Gate 

The results of simulation using BPM is shown in Fig. 6.5, where the AND gate is seen 

to give acceptable results through proper selection of control signals. The operating 

principle of the proposed structure can be well monitored using the truth table, Table. 

6.2. The results of simulation based analysis have been compared with the BPM 

results for its validation and verification as shown in Fig. 6.5.  

Table 6.2: Inputs and outputs of AND Gate layout 

Control/

Input 

Signals 

 

Outputs 

A B Port 1  

(C = A AND B) 

Port 2 Port 3 

 

0 0 0 0 1 

0 1 0 0 1 

1 0 0 1 0 

1 1 1 0 0 
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Figure 6.5: Results of AND Gate using beam propagation method 

Impact of Ti strip thickness on IL and ER  

In this, impact of Ti strip thickness on power performance of the AND gate has been 

investigated by varying the thickness of Ti strip from 0.05 µm to 0.09 µm and plot the 

graph between the extinction ratio and the thickness of titanium strip and insertion 

loss and thickness of titanium strip. And we obtain the highest value 15.13 dB of 

extinction ratio and lowest value of insertion loss 0.128 dB at the 0.05 µm thickness 

and we increase or decrease the titanium thickness the extinction ratio will be low and 

insertion ratio will be high. 

 

(a)                  (b) 

Figure 6.6: (a) Variation of ER with increase in thickness of Ti strip of AND Gate (b) Variation of IL 

with increase in thickness of Ti strip of AND Gate 



CHAPTER 6: PROPOSED DESIGNS OF OPTICAL LOGIC GATES AND HALF ADDER 

 

MNIT JAIPUR                                                     Page 40 
 

6.3 OR GATE 

To implement the OR gate three MZI’s were used, as represented in Fig. 4.5. At the 

input of MZI-1 and MZI-2 the optical signal is applied and second port of MZI-3 is 

taken as output of OR gate shown in the figure. Fig. 6.7 shows the structure and 

results of the implemented OR gate using OptiBPM. 

 

Figure 6.7: Layout structure of OR Gate 

The results of simulation using BPM is shown in Fig. 6.8, where the OR gate is seen 

to give acceptable results through proper selection of control signals. The operating 

principle of the proposed structure can be well monitored using the truth table, Table. 

6.3. The results of simulation based analysis have been compared with the BPM 

results for its validation and verification as shown in Fig. 6.8.  

Table 6.3: Inputs and outputs of OR Gate layout 

Control/

Input 

Signals 

 

Outputs 

A B Port 1  

 

Port 2 Port 3 

(S = A OR B) 

0 0 1 0 0 

0 1 1 0 1 

1 0 0 0 1 

1 1 0 1 1 
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Figure 6.8: Results of OR Gate using beam propagation method 

Impact of Ti strip thickness on IL and ER  

In this, impact of Ti strip thickness on power performance of the OR gate has been 

investigated by varying the thickness of Ti strip from 0.05 µm to 0.09 µm and plot the 

graph between the extinction ratio and the thickness of titanium strip and insertion 

loss and thickness of titanium strip. And we obtain the highest value 9.332 dB of 

extinction ratio and lowest value of insertion loss 2.531 dB at the 0.05 µm thickness 

and we increase or decrease the titanium thickness the extinction ratio will be low and 

insertion ratio will be high.   

 

(a)      (b) 

Figure 6.9: (a) Variation of ER with increase in thickness of Ti strip of OR Gate (b) Variation of IL 

with increase in thickness of Ti strip of OR Gate 
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6.4 NOR GATE 

To implement the NOR gate two MZI’s were used, as represented in Fig. 4.7.  

At the input of MZI-1 the optical signal is applied and first port of MZI-2 is taken as 

output of NOR gate shown in the figure. Fig. 6.10 shows the structure and results of 

the implemented NOR gate using OptiBPM  

 

Figure 6.10: Layout structure of NOR Gate 

The results of simulation using BPM is shown in Fig. 6.11, where the NOR gate is 

seen to give acceptable results through proper selection of control signals. The 

operating principle of the proposed structure can be well monitored using the truth 

table, Table. 6.4. The results of simulation based analysis has been compared with the 

BPM results for its validation and verification as shown in Fig. 6.11  

 

Table 6.4: Inputs and outputs of NOR Gate layout 

Control/

Input 

Signals 

 

Outputs 

A B Port 1  

 

Port 2 

(Y = A NOR B) 

Port 3 

 

0 0 0 1 0 

0 1 0 0 1 

1 0 1 0 0 

1 1 1 0 0 
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Figure 6.11: Results of NOR Gate using beam propagation method 

Impact of Ti strip thickness on IL and ER  

In this, impact of Ti strip thickness on power performance of the NOR gate has been 

investigated by varying the thickness of Ti strip from 0.05 µm to 0.09 µm and plot the 

graph between the extinction ratio and the thickness of titanium strip and insertion 

loss and thickness of titanium strip. And we obtain the highest value 29.85 dB of 

extinction ratio and lowest value of insertion loss 1.103 dB at the 0.05 µm thickness 

and we increase or decrease the titanium thickness the extinction ratio will be low and 

insertion ratio will be high. 
 

 

 

(a)      (b) 

Figure 6.12: (a) Variation of ER with increase in thickness of Ti strip of NOR Gate (b) Variation of IL 

with increase in thickness of Ti strip of NOR Gate 
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6.5 NAND GATE 

To implement the NAND gate three MZI’s were used, as represented in Fig. 4.9. At 

the input of MZI-1 and MZI-2 the optical signal is applied and first output port of 

MZI-3 is taken as output of NAND gate shown in the figure. Fig. 6.13 shows the 

structure and results of the implemented NAND gate using OptiBPM. 

 

Figure 6.13: Layout structure of NAND Gate 

The results of simulation using BPM is shown in Fig. 6.14, where the NAND gate is 

seen to give acceptable results through proper selection of control signals. The 

operating principle of the proposed structure can be well monitored using the truth 

table, Table. 6.5. The results of simulation based analysis have been compared with 

the BPM results for its validation and verification as shown in Fig. 6.14.  

Table 6.5: Inputs and outputs of NAND Gate layout 

Control/

Input 

Signals 

 

Outputs 

A B Port 1  

 

Port 2 

(Y = A NAND B) 

Port 3 

 

0 0 0 1 1 

0 1 0 1 0 

1 0 1 1 0 

1 1 1 0 0 
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Figure 6.14: Results of NAND Gate using beam propagation method 

Impact of Ti strip thickness on IL and ER  

In this, impact of Ti strip thickness on power performance of the NAND gate has been 

investigated by varying the thickness of Ti strip from 0.05 µm to 0.09 µm and plot the 

graph between the extinction ratio and the thickness of titanium strip and insertion 

loss and thickness of titanium strip. And we obtain the highest value 17.86 dB of 

extinction ratio and lowest value of insertion loss 3.182 dB at the 0.05 µm thickness 

and we increase or decrease the titanium thickness the extinction ratio will be low and 

insertion ratio will be high. 

 

(a)      (b) 

Figure 6.15: (a) Variation of ER with increase in thickness of Ti strip of NAND Gate (b) Variation of 

IL with increase in thickness of Ti strip of NAND Gate 
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6.6 XOR GATE 

To implement the XOR logic two MZI’s were used, as represented in Fig. 4.11. At the 

input of MZI-1 the optical signal is applied and second output port of MZI-2 is taken 

as the output XOR operation. Fig. 6.16 shows the structure and results of the XOR 

gate using OptiBPM. 

 

Figure 6.16: Layout structure of XOR Gate 

The results of simulation using BPM is shown in Fig. 6.17, where the XOR gate is 

seen to give acceptable results through proper selection of control signals. The 

operating principle of the proposed structure can be well monitored using the truth 

table, Table. 6.6. The results of simulation based analysis has been compared with the 

BPM results for its validation and verification as shown in Fig. 6.17.  

Table 6.6: Inputs and outputs of XOR Gate layout 

Control/

Input 

Signals 

 

Outputs 

A B Port 1  

 

Port 2 

(C = A XOR B) 

0 0 1 0 

0 1 0 1 

1 0 0 1 

1 1 1 0 
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Figure 6.17: Results of XOR Gate using beam propagation method 

Impact of Ti strip thickness on IL and ER  

In this, impact of Ti strip thickness on power performance of the XOR gate has been 

investigated by varying the thickness of Ti strip from 0.05 µm to 0.09 µm and plot the 

graph between the extinction ratio and the thickness of titanium strip and insertion 

loss and thickness of titanium strip. And we obtain the highest value 13.84 dB of 

extinction ratio and lowest value of insertion loss 0.128 dB at the 0.05 µm thickness 

and we increase or decrease the titanium thickness the extinction ratio will be low and 

insertion ratio will be high. 

 

(a)      (b) 

Figure 6.18: (a) Variation of ER with increase in thickness of Ti strip of XOR Gate (b) Variation of IL 

with increase in thickness of Ti strip of XOR Gate 
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6.7 XNOR GATE 

To implement the XNOR logic two MZI’s were used, as represented in Fig. 4.13. At 

the input of MZI-1 the optical signal is applied and first output port of MZI-2 is taken 

as the output XNOR operation. Fig. 6.19 shows the structure and results of XNOR 

gate using OptiBPM. 
 

 

Figure 6.19: Layout structure of XNOR Gate 

The results of simulation using BPM is shown in Fig. 6.20, where the XNOR gate is 

seen to give acceptable results through proper selection of control signals. The 

operating principle of the proposed structure can be well monitored using the truth 

table, Table. 6.7. The results of simulation based analysis have been compared with 

the BPM results for its validation and verification as shown in Fig. 6.20.  

Table 6.7: Inputs and outputs of XNOR Gate layout 

Control/

Input 

Signals 

 

Outputs 

A B Port 1  

(C = A XNOR B) 

Port 2 

0 0 1 0 

0 1 0 1 

1 0 0 1 

1 1 1 0 
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Figure 6.20: Results of XNOR Gate using beam propagation method 

Impact of Ti strip thickness on IL and ER  

In this, impact of Ti strip thickness on power performance of the XNOR gate has been 

investigated by varying the thickness of Ti strip from 0.05 µm to 0.09 µm and plot the 

graph between the extinction ratio and the thickness of titanium strip and insertion 

loss and thickness of titanium strip. And we obtain the highest value 16.35 dB of 

extinction ratio and lowest value of insertion loss 0.215 dB at the 0.05 µm thickness 

and we increase or decrease the titanium thickness the extinction ratio will be low and 

insertion ratio will be high. 

 

(a)                        (b) 

Figure 6.21: (a) Variation of ER with increase in thickness of Ti strip of XNOR Gate (b) Variation of 

IL with increase in thickness of Ti strip of XNOR Gate 
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6.8 HALF ADDER 

To implement the half adder three MZI’s were used, as represented in Fig. 4.15. At 

the input of MZI-1 the optical signal is applied and second output port of MZI-2 is 

taken as the output port of the circuit giving the resultant sum of the half adder circuit 

implemented (XOR operation) and the carry generated by the circuit can be obtained 

at first output port of MZI-3 as shown in the figure. Fig. 6.22 shows the structure and 

results of the implemented half adder using OptiBPM. 

 

Figure 6.22: Layout structure of Half Adder 

The results of simulation using BPM is shown in Fig. 6.23, where the half adder is 

seen to give acceptable results through proper selection of control signals. The 

operating principle of the proposed structure can be well monitored using the truth 

table, Table. 6.8. The results of simulation based analysis have been compared with 

the BPM results for its validation and verification as shown in Fig. 6.23.  

Table 6.8: Inputs and outputs of half adder layout 

Control/

Input 

Signals 

 

Outputs 

A B Port 1  

(C = A AND B) 

Port 2 Port 3 

(S = A XOR B) 

0 0 0 1 0 

0 1 0 0 1 

1 0 0 0 1 

1 1 1 0 0 
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Figure 6.23: Results of half adder using beam propagation method 

Impact of Ti strip thickness on IL and ER  

In this, impact of Ti strip thickness on power performance of the half adder has been 

investigated by varying the thickness of Ti strip from 0.05 µm to 0.09 µm and plot the 

graph between the extinction ratio and the thickness of titanium strip and insertion 

loss and thickness of titanium strip. And we obtain the highest value 28.68 dB of 

extinction ratio and lowest value of insertion loss 0.024 dB at the 0.05 µm thickness 

and we increase or decrease the titanium thickness the extinction ratio will be low and 

insertion ratio will be high. 

 

(a)                      (b) 

Figure 6.24: (a) Variation of ER with increase in thickness of Ti strip of half adder (b) Variation of IL 

with increase in thickness of Ti strip of half adder 
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CHAPTER 7: CONCLUSION AND FUTURE ASPECTS 

7.1 Conclusion 

In this thesis electro-optic effect has been used in realization of all optical logic gates 

and half adder circuit using MZIs and beam propagation method has been used for 

simulation. The advantage of the proposed design is that it requires less number of 

components than those implemented using SOA-MZI [10]. The results have been 

compared and verified using MATLAB simulations. The impact of Ti strip thickness 

variation on the device performance has also been analysed via evaluation of IL and 

ER. It can be concluded from the analysis that optimum performance of the device can 

be ensured when Ti strip thickness of 0.05 µm is chosen. The values of ER and IL are 

obtained theoretically and following values are obtained 

 For NOT gate the lowest value of IL obtained in this work is 0.050dB and the 

maximum value of ER obtained is 26.86 dB. 

 For AND gate the lowest value of IL obtained in this work is 0.128dB and the 

maximum value of ER obtained is 15.13 dB. 

 For OR gate the lowest value of IL obtained in this work is 2.531dB and the 

maximum value of ER obtained is 9.332 dB. 

 For NOR gate the lowest value of IL obtained in this work is 1.103dB and the 

maximum value of ER obtained is 29.85 dB. 

 For NAND gate the lowest value of IL obtained in this work is 3.182dB and 

the maximum value of ER obtained is 17.86 dB. 

 For XOR gate the lowest value of IL obtained in this work is 0.128dB and the 

maximum value of ER obtained is 13.84 dB. 

 For XNOR gate the lowest value of IL obtained in this work is 0.215dB and 

the maximum value of ER obtained is 16.35 dB. 

 For Half Adder gate the lowest value of IL obtained in this work is 0.024dB 

and the maximum value of ER obtained is 26.86 dB. 

7.2 Future Aspects 

In future, more improvement can be made in the optical logic gates and half adder 

designs. Future work can be done on following parameters of these modulator 

designs- 
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 Size: size can be further reduced for this type of combinational circuit design, 

compact size devices will result in more small design with lower power 

consumption. 

 Switching Voltage: By reducing the switching voltage more power efficient 

designs can be made, reduction in switching voltage will result in a decrement 

of switching voltage length product parameter of MZI structure which is 

desirable. 

 Insertion Loss: lower value of insertion loss for any device is desirable, by 

working on these designs one can reduce the value of insertion loss more than 

three digits after decimal point. 

 Extinction Ratio: higher value of ER is desirable. So, working on these designs 

one can increase the value of Extinction Ratio. 

 More combinational and sequential circuits can be design using electro optic 

effect in Mach- Zehnder Interferometer. 

  



BIBLIOGRAPHY 

 

MNIT JAIPUR                                                     Page 54 
 

BIBLIOGRAPHY 

[1] Kumar, Harsh, Laxman Kumar, Vijay Janyani, Buryy Oleh, Ubizskii Serhij, 

and Ghanshyam Singh. "Gray to binary code converter using Ti-indiffused 

lithium niobate based Mach-Zehnder interferometer." In Advances in Optical 

Science and Engineering, pp. 257-262. Springer, Singapore, 2017. 

[2] Singh, Ghanshyam, Vijay Janyani, and R. P. Yadav. "Modeling of a high 

performance Mach--Zehnder interferometer all optical switch." Optica 

Applicata 42, no. 3 (2012). 

[3] Singh, G., V. Janyani, and R. P. Yadav. "Modeling of a 2× 2 electro-optic 

Mach-Zehnder Interferometer optical switch with s-bend arms." Photonics 

letters of Poland 3, no. 3 (2011): 119-121. 

[4] Kumar, Santosh, Sanjeev Kumar Raghuwanshi, and Ajay Kumar. 

"Implementation of optical switches using Mach–Zehnder 

interferometer." Optical Engineering 52, no. 9 (2013): 097106. 

[5] Kumar, Ajay, and Sanjeev Kumar Raghuwanshi. "Implementation of optical 

gray code converter and even parity checker using the electro-optic effect in 

the Mach–Zehnder interferometer." Optical and Quantum Electronics 47, no. 7 

(2015): 2117-2140. 

[6] Ganguly, P., D. C. Sen, S. Datt, J. C. Biswas, and S. K. Lahiri. "Simulation of 

refractive index profiles for titanium indiffused lithium niobate channel 

waveguides." Fiber & Integrated Optics 15, no. 2 (1996): 135-147. 

[7] Kumar, Santosh, Gurdeep Singh, Ashish Bisht, and Angela Amphawan. 

"Design of D flip-flop and T flip-flop using Mach–Zehnder interferometers for 

high-speed communication." Applied optics 54, no. 21 (2015): 6397-6405. 

[8] Singh, G., R. P. Yadav, and V. Janyani. "Ti indiffused lithium niobate (Ti: 

LiNbO3) Mach-Zehnder interferometer all optical switches: a review." In New 

Advanced Technologies. IntechOpen, 2010. 

[9] Bremer, T., P. Hertel, S. Oelschig, R. Sommerfeldt, and W. Heiland. "Depth 

profiling of magnesium-and titanium-doped LiNbO3 waveguides." Thin Solid 

Films 175 (1989): 235-239. 

[10] Kumar, Ajay, Santosh Kumar, and Sanjeev Kumar Raghuwanshi. 

"Implementation of full-adder and full-subtractor based on electro-optic effect 



BIBLIOGRAPHY 

 

MNIT JAIPUR                                                     Page 55 
 

in Mach–Zehnder interferometers." Optics Communications 324 (2014): 93-

107. 

[11] Kumar, Santosh, Gurdeep Singh, Ashish Bisht, Sandeep Sharma, and Angela 

Amphawan. "Proposed new approach to the design of universal logic gates 

using the electro-optic effect in Mach–Zehnder interferometers." Applied 

optics 54, no. 28 (2015): 8479-8484. 

[12] Kumar, Ajay, Santosh Kumar, and Sanjeev Kumar Raghuwanshi. 

"Implementation of XOR/XNOR and AND logic gates by using Mach–

Zehnder interferometers." Optik-International Journal for Light and Electron 

Optics 125, no. 19 (2014): 5764-5767. 

[13] Kumar, Santosh, and Sanjeev Kumar Raghuwanshi. "Design of optical 

reversible logic gates using electro-optic effect of lithium niobate based Mach–

Zehnder interferometers." Applied optics 55, no. 21 (2016): 5693-5701. 

[14] Kumar, Santosh, Ashish Bisht, Gurdeep Singh, Kuldeep Choudhary, K. K. 

Raina, and Angela Amphawan. "Design of 1-bit and 2-bit magnitude 

comparators using electro-optic effect in Mach–Zehnder 

interferometers." Optics Communications357 (2015): 127-147. 

[15] Raghuwanshi, Sanjeev Kumar, Ajay Kumar, and Azizur Rahman. 

"Implementation of high speed optical universal logic gates using the electro-

optic effect-based Mach–Zehnder interferometer structures." Journal of 

Modern Optics 62, no. 12 (2015): 978-988. 

[16] Mohammed, Nazmi A., Huda S. Abo Elnasr, and Moustafa H. Aly. 

"Performance Evaluation and Enhancement of 2× 2 Ti: LiNbO3 Mach 

Zehnder Interferometer Switch at 1.3 μm and 1.55 μm." The Open Electrical & 

Electronic Engineering Journal 6, no. 1 (2012). 

[17] Zetie, K. P., S. F. Adams, and R. M. Tocknell. "How does a Mach-Zehnder 

interferometer work?." Physics Education 35, no. 1 (2000): 46. 

[18] Rendón-Salgado, I., and R. Gutiérrez-Castrejón. "160 Gb/s all-optical AND 

gate using bulk SOA turbo–switched Mach–Zehnder interferometer." Optics 

Communications 399 (2017): 77-86. 

[19] Khatun, Rabeya, Kazi Tanvir Ahmmed, A. Zahed Chowdhury, and Raqibul 

Hossen. "Optimization of 2× 2 MZI electro-optic switch and its application as 

logic gate." In 2015 18th International Conference on Computer and 

Information Technology (ICCIT), pp. 294-299. IEEE, 2015. 



BIBLIOGRAPHY 

 

MNIT JAIPUR                                                     Page 56 
 

[20] Kumar, Santosh, Ajay Kumar, and Sanjeev Kumar Raghuwanshi. 

"Implementation of an optical AND gate using Mach-Zehnder 

interferometers." In Optical Modelling and Design III, vol. 9131, p. 913120. 

International Society for Optics and Photonics, 2014. 

[21] Choudhary, Kuldeep, and Santosh Kumar. "Design of pseudorandom binary 

sequence generator using lithium-niobate-based Mach–Zehnder 

interferometers." Optical Engineering 56, no. 5 (2017): 057104. 

[22] Arvidsson, Gunnar, Kurt Bergvall, and Anders Sjöberg. "Processing of 

titanium-diffused lithium niobate waveguide devices and waveguide 

characterization." Thin Solid Films126, no. 3-4 (1985): 177-184. 

[23] MS Windows NT introduction of bpm. https://optiwave.com/optibpm-  

manuals/bpm-introduction-to-optibpm/. Accessed: 2019-06-04. 

[24] MS Windows NT mzi switch optiwave. 

https://optiwave.com/category/optibpm -manuals/optibpm-tutorials/p-lesson-

14-mach-zehnder-interferometer-switch/. Accessed: 2019-06-03. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



LIST OF PUBLICATION 

 

MNIT JAIPUR                                                     Page 57 
 

LIST OF PUBLICATION 

 

1. Manisha Prajapat, Ankur Saharia and Ghanshyam Singh, “Design of Half Adder 

using Electro-Optic Effect in Mach-Zehnder Interferometer” International 

Conference on Optical and Wireless Technologies (OWT 2019), Springer, Jaipur, 

India, March 2019. 

 

2. Avneesh , Manisha Prajapat, Ramgopal Ramineni and Rahul, “Study, Design and 

Evaluation of performance parameters of Optical Logic Gate (NOR)” IETE 

conference on  Advances in Electronic Circuit and Systems, SKIT, Jaipur, April 

2018.  

 

 



12%
SIMILARITY INDEX

3%
INTERNET SOURCES

11%
PUBLICATIONS

3%
STUDENT PAPERS

1 2%

2 1%

3 1%

Thesis
ORIGINALITY REPORT

PRIMARY SOURCES

Santosh Kumar, Gurdeep Singh, Ashish Bisht,
Sandeep Sharma, Angela Amphawan.
"Proposed new approach to the design of
universal logic gates using the electro-optic
effect in Mach–Zehnder interferometers",
Applied Optics, 2015
Publicat ion

Santosh Kumar, Sanjeev Kumar Raghuwanshi,
B. M. A. Rahman. "Design of universal shift
register based on electro-optic effect of
LiNbO3 in Mach–Zehnder interferometer for
high speed communication", Optical and
Quantum Electronics, 2015
Publicat ion

Vijay Sivan, Arnan Mitchell, Lam Bui, Anthony
Holland, Suresh Bhargava, Timothy Priest.
"Etching of lithium niobate using standard Ti
indiffusion technique", Applied Physics Letters,
2007
Publicat ion

Robert J. Simpson, Trevor J. Terrell. "Digital


	Thesis
	ORIGINALITY REPORT
	PRIMARY SOURCES


